
 
 
 
 
 
 

 
 

 
  
  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 

 
 

 
  

         

Wildland Fire 
GIS Specialist Incident Workflow 

Version 1.0 
February 2019 

Executive Summary: The GISS Workflow was developed as a training and refresher resource to provide 
a single workflow for reference on wildland fire incidents. The GISS Workflow aims to bring together 
other training and outreach materials targeted to GIS Specialists in one single, process oriented 
document. Varying degrees of detail are provided in this document with reference links throughout. A 
single page flow-chart based workflow, two page high level workflow, and a detailed multi-page 
workflow are provided to assist GISS. GISS trainees and experienced GISS should review this 
document to assist in incident response. Many new techniques are included such as using the new Event 
geodatabase and working with the National Incident Feature Service. 
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GISS Workflow - 2 Page 

Definitions: 
Local Copy - Refers to multiple software specific options for the GDB used for editing feature services. The 
incident will be a Local Copy (ArcMap or ArcGIS Pro) from the National Incident Feature Service (NIFS) in a 
system folder. Note that this is not the same GDB that is used for mapping purposes. Local copies should exist 
only during editing and preferably less than an hour to avoid conflicts. Not available with ArcMap Basic license. 
Master Incident GDB - The most current GDB named per GSTOP standards ({year}_{incident name}_{unit ID 
+ local incident ID}) and is placed in the incident_data folder to be used as the source for all incident maps. This 
GDB should not be edited. 
Edit Incident GDB - A GDB copy for editing named per GSTOP standards ({year}_{incident name}_{unit ID + 
local incident ID}_edit) and is placed in the incident_data\edit folder. This allows other GISS to continue map 
production using Master Incident GDB. Should only use when ICP has no internet access. The GDB is backed up 
and used to overwrite the Master Incident GDB, after edits are finalized. 
Edit Project - The map document (.mxd) or project (.aprx) used for editing the Edit Incident GDB or Local Copy. 
Editing should not be done in any project used for mapping. The project stores your configured feature templates. 

Assignment Preparation - Do Once 
1. Gather incident information - Name, Unit ID, IRWINID, etc. 
2. Copy the GSTOP incident directory structure to hard drive. Rename for incident. 
3. Populate the base_data folder with data relevant to the fire area. 
4. Open and save a new map document (ArcMap) or project (Pro) to be the Edit Project. Name per 

GSTOP standards {map type} = “edit”. 
a. Internet Access? (if possible before leaving for incident). 

i. YES - Create a Local Copy: 
1. Zoom to incident area of interest (AOI). 
2. Add the National Incident Feature Service (NIFS). 
3. Create a Local Copy (ArcMap) or Download Map (ArcGIS Pro). 

ii. NO - Create an Edit Incident GDB in the incident_data\edit folder and rename to 
GSTOP standard and add _edit to the end of GDB name. 

b. Add template layer file and repair path to point to GDB (Local or Edit). 
c. Set data frame coordinate system to local projection. 
d. Configure Feature Templates. 
e. Save a group layer file for Event in the incident_data folder and include your name. 

Edit Cycle - Repeat as Necessary 
5. Edit the GDB (Local Copy or Edit Incident GDB). 

a. Secure information through SITL to create/edit incident data. 
b. Process/Convert/Import incoming data and store per GSTOP file structure. 
c. Open the Edit Project and create a new Local Copy if necessary (watch AOI and only edit 

your incident). Edit the GDB. 
i. Edit the EventPolygon first. Calculate Geometries and populate attributes. 

ii. Edit the coincident EventLine features to match the fire polygon. Calculate Geometries 
and populate attributes. 

iii. Edit the EventPoint or EventLine features in a logical order. Calculate Geometries and 
populate attributes. 
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d. Save data edits and save Edit Project. 
e. Export latest fire perimeter to a progression GDB for use in the progression maps. 
f. Calculate containment, ownership acres, etc. 

Backup and Update the Master Incident GDB - Done after every Edit Cycle 
6. Internet Access? 

a. YES - Sync and then Backup Local Copy (ArcMap) or Download Map (ArcGIS Pro) 
i. Determine the path and name of the Local Copy. 
ii. Synchronize Local Copy with the NIFS. 
iii. Create a copy of the Local Copy, paste into the daily backup folder under 

incident_data\backups and rename following GSTOP. 
b. NO - Backup Edit Incident GDB 

i. Copy the Edit Incident GDB in incident_data\edit and paste into the backup folder 
under incident_data\backups. Rename following GSTOP. 

ii. Upload a copy of the backup to Fire Enterprise Geospatial Portal (EGP) when internet 
becomes available. 

7. Replace Master Incident GDB - use the current GDB backup to overwrite the Master Incident GDB 
with the newest incident data. Maintain GSTOP naming convention. 

Map Cycle - Repeat as Necessary 
8. Create or Update Incident Map(s) 

a. Use existing master incident project or open a template and save as a master project per 
GSTOP. 

b. Set data frame coordinate system to local projection. 
c. Add layer file(s) and repair path to point to the Master Incident GDB. 
d. Add base maps and ancillary datasets to map. 
e. Create a layout for the desired map product or apply template to existing project. 
f. Use definition queries to display only the Event features appropriate for the intended map 

audience. 
g. Create division and branch (if necessary) annotation. 
h. Use dynamic labelling or create annotation in separate GDB (in Other_Incident_Data.gdb) for 

other features. 
i. Ensure that all essential map elements are present and correct (STANDL SGD). 
j. Export geospatial PDF map per GSTOP standards. 
k. Backup map documents in projects\backups folder per GSTOP. 

Backup and Post - Repeat as Necessary 
9. Post map products to NIFC FTP site nightly. Use QR codes to reference folders if desired. 
10. Backup incident directory structure. 

**** If additional GDB edits are needed the Master Incident GDB should not be edited. Only the Local 
Copy or Edit Incident GDB should be edited**** 
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GISS Workflow - EXPANDED 

This is the expanded version of the 2 page GISS Workflow document and is designed to provide 
additional details, links and tips for each part of the workflow. This document is designed as a reference 
for qualified GISS and GISS Trainees. 

Reference materials from the GISS Introductory Class and ArcGIS Help resources are linked 
throughout. Working in a group environment is encouraged and helps simulate working on an actual 
incident. 

NOTE: Make sure to save MXDs, APRXs, and edits often and routinely. 

Assignment Preparation - Do Once 
How To: ArcMap, ArcGIS Pro 

1) Gather incident information. Add information to the GSTOP File Namer spreadsheet to easily create 
GSTOP compliant file names. 
a) Review Using and Customizing the GSTOP File Namer PDF or Video for tips. 
b) Refer to Locating the IRWIN ID and Other Important Attributes for additional information on 

finding key attributes. 

2) Copy the GSTOP incident directory structure to hard drive. Place as close to the root of hard drive as 
possible to reduce clicks to find data. Rename following GSTOP standards. 
a) Directory structure templates can be downloaded from the Tools page of the GIS Specialist 

Training site. 
b) Method of Work - GSTOP Directory Structure 
c) Video: GSTOP File Naming and Directory Structure 

3) Populate the base_data folder with data relevant to the fire area. Sources of data include: 
a) NIFC FTP 1:24,000 scale USGS topographic maps converted to geotiff files. 
b) USFS FSTopo 1:24,000 scale USFS topographic maps. 
c) National Interagency Fire Center ArcGIS Online Organization. 
d) USGS Hazards Data Distribution System (HDDS) for Fire 

4) Open and Save a new map document, to create the Edit Project. Name per GSTOP standards: {map 
type} = “edit”. 
a) Internet Access? 

i) YES - Create a Local Copy or Download Map. 
(1) Zoom to Area of Interest. The Local Copy (ArcMap) or Download Map (ArcGIS Pro) 

tools will only pull down data in the map view. 
(2) Add the National Incident Feature Service (NIFS). 

(a) Video: Connecting to the Incident Feature Service. 
(b) An EGP account is required to access the NIFS. Connecting to the GIS Server will 

require EGP username and password. 
(c) Create a connection to the EGP ArcGIS Server. 
(d) Select the correct server URLs when creating the connection. There are options for 

Production (incidents only!) and Training. 
(e) Once the connection is made add the Event_GISSEdit feature service to the map. 
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https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass
http://desktop.arcgis.com/en/arcmap/
https://drive.google.com/file/d/1zKH1AXC_HH8Tz6AYGWrnmnT8XiE_pjv3/view
https://drive.google.com/file/d/10jHn9od8jfOj6X_STZIxf7F9OYBwhsiu/view
https://drive.google.com/file/d/0B0bv14RMaOcfRzB2ZjUyRkNtam8/view?usp=sharing
https://drive.google.com/file/d/1ZONwWQspydj5LahNcETmrGKS_H0hQ32P/view
https://www.youtube.com/watch?v=BK5pXkyZoGU
https://drive.google.com/file/d/1qhFT_Io-x8aXIEAvXb4__oHsDqlKtgKU/view
https://drive.google.com/file/d/1ory1WhNhLgFtUDPxpk2ol-81TRPX49cC/view
https://sites.google.com/a/firenet.gov/gisstraining/home/tools
https://drive.google.com/file/d/0B0bv14RMaOcfeWQ1S2Q0VV9yTHM/view
https://www.youtube.com/watch?v=c_OrSDw_m-0
https://ftp.nifc.gov/public/base_info/topo_maps/
https://data.fs.usda.gov/geodata/rastergateway/states-regions/states.php
https://nifc.maps.arcgis.com/home/index.html
https://hddsexplorer.usgs.gov/fire/
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/a_editingfeatureservices
https://www.youtube.com/watch?v=AfUHiGy8e7c
https://egp.nwcg.gov/egp/default.aspx
http://enterprise.arcgis.com/en/server/10.5/install/windows/making-a-user-connection-to-arcgis-server-in-arcgis-for-desktop.htm
https://egp.nwcg.gov/arcgisimt/rest/services
https://egptest.nwcg.gov/arcgisimt/rest/services
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(3) Review Area of Interest and make sure all of the fire features needed are in map view. If 
neighboring fires are included in the download, DO NOT edit or delete other fire’s data. 

(4) Create Local Copy or Download Map. 
(a) NOTE: Users with a ArcMap Basic license CANNOT create a local copy. 

ii) NO - Create an Edit Incident GDB. Copy a blank Event GDB from the \tools folder to the 
\incident_data\edit folder to create the Edit Incident GDB. Appropriately name it per GSTOP 
standards (don’t forget _edit). 

b) Add template layer files and repair path. 
i) From the Add Data window add the 2019_Event_Features_PointLabelsDefined.lyr Layer 

File from the \tools folder into the map. 
ii) Set the data source on the EventPoint layer by clicking on the red exclamation point and then 

select the EventPoint feature class in the Edit Incident GDB. All three Event Features should 
update. 

iii) Note: always add the layer file via the Add Data dialog or Catalog window. Doing this will 
ensure that the labeling and feature templates associated with the layer files will be added, 
not just the symbology. 

c) Set the data frame to the preferred local projection. If the local projection is unknown set the 
dataframe to UTM NAD83 and zone based on the incident location. 

d) Configure the feature template for all three event layers using the incident information from the 
resource order provided. Resource: Unit 2A How To- Prepare and Configure the Event GDB for 
ArcMap or ArcGIS Pro. 
i) Set up the feature templates by selecting each feature class, right clicking and selecting Edit 

Features > Organize Feature Templates. 
ii) Select everything in the list and enter personal contact information and the incident attributes 

into the feature templates from Resource Order, IRWIN, or ask the SITL for the correct IDs. 
iii) The Feature Templates will automatically populate any new features with the attributes 

provided. This saves significant time during an incident by cutting down on attribute data 
entry. 

iv) Extra copies of the blank Event GDB and layer files can be found in \tools folder of the 
standard template file structure. 

e) Save a group layer file for the Event feature classes in the incident_data\edit folder. Use the 
same name as Edit Incident GDB and add your name. Use this layer file recreate the edit project 
as necessary, only edit incident data from the edit project. Save the Edit Project. 

f) If using a Local Copy, sync edits back to the service immediately after completing them and do 
not keep a download any longer than necessary to avoid overwriting field edits. 
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https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
http://desktop.arcgis.com/en/arcmap/10.5/manage-data/editing-fundamentals/about-editing-data-from-feature-services.htm
http://pro.arcgis.com/en/pro-app/help/projects/take-a-map-offline.htm
https://drive.google.com/file/d/1J7AoV2Nnv7AVstI3Pt4ZRN2uwYM8O7bD/view
https://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/EventGDB
https://drive.google.com/file/d/1zKH1AXC_HH8Tz6AYGWrnmnT8XiE_pjv3/view
https://drive.google.com/file/d/10jHn9od8jfOj6X_STZIxf7F9OYBwhsiu/view
https://drive.google.com/file/d/1qhFT_Io-x8aXIEAvXb4__oHsDqlKtgKU/view?usp=sharing
https://drive.google.com/open?id=1ory1WhNhLgFtUDPxpk2ol-81TRPX49cC
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
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Edit Cycle - Repeat As Necessary 
5) Edit the GDB - Local Copy (ArcMap), Download Map (ArcGIS Pro), or Edit Incident GDB (No 

Internet). Resource: Unit 2B How To: Editing the Event GDB in ArcMap or ArcGIS Pro. How To: 
Tips and Tricks and ESRI presentation: ArcMap Editing Tricks and Tips. 
a) Secure information through Situation Unit Leader (SITL) to create/edit incident data. 

i) Add any base or ancillary data necessary to make the required edits. Keep data layers to a 
minimum in the Edit Project to make selections easier and reduce clutter. 

ii) Format topo maps. 
(1) Clear the white and green colors in topo maps by setting background transparent to allow 

placement of polygons with solid fill colors beneath the topo map. 
(2) Set the background transparent on one topo and use the Layer Properties > Symbology 

tab to Import the settings to other topos. 
(3) Group and name the the topos appropriately so they can all be turned off quickly with one 

click. 
(4) Save the group as a layer file for later use. 

b) Process, Convert, or Import incoming data and store per GSTOP file structure. GSTOP Filename 
Components. 
i) Video: Working with Incident Data Part 1 and Part 2 review how to process and incorporate 

different types of data. 
ii) Use the Toolbox tool GPX to Features to import GPX data. The tool can be found at 

Conversion Tools > From GPS > GPX to Features. 
iii) Use the Toolbox tool KML to Layer to import KML data. The tool can be found at 

Conversion Tools > From KML > KML to Layer. 
iv) Use File > Add Data > Add X/Y Data to import coordinate pair data. 
v) DNRGPS can also be used to work with GPS and KML data. 

c) Open the Edit Project and create a new Local Copy or synchronize your Download Map if 
necessary (watch AOI and only edit assigned incident). 
i) Edit the EventPolygon Feature Class first. (How To: Pro, ArcMap) 

(1) Refer to Utilizing the Event Attributes How To or Video for attribute descriptions and 
how to use the Event GDB for various mapping scenarios. 

(2) Use any new perimeter data that has been received to update the polygon. 
(a) NIROPS perimeters are generally very accurate and can be traced, aligned to, and 

sometimes used to replace the entire fire polygon on new or small fires. 
(b) Use the Attribute Editor window to update the attributes. Attributes can be updated 

singularly or in bulk by selecting multiple features in the Attribute Editor window. 
(c) It will vary by feature, but all relevant attributes constitute Required Metadata. The 

following fields must be populated for every feature: 
IncidentName ContactName UnitID 

MapMethod ContactEmail LocalIncidentID 

FeatureAccess ContactPhone IRWINID 

FeatureStatus Point/Line/PolyDateTime 

IsVisible GACC 
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https://drive.google.com/file/d/11DWLTOCFA7rXs6QGCJI1r336M4-ACLr2/view
https://drive.google.com/file/d/1qzh7y6LlK-H6h2_daNLX2nv0ox_i3SYe/view
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/editingtipstricks
https://drive.google.com/file/d/1wSq-T6BbFgTj3GjHX96mBfqmvYKkB789/view
https://drive.google.com/file/d/1QgDnNy1hvB0-WNLucPzeP9gw7PeImJeI/view
https://drive.google.com/file/d/1ZhxP5kEhmnrh-uw7Rz1wt79rUqKcmwS8/view?usp=sharing
http://proceedings.esri.com/library/userconf/fed16/papers/fed_22.pdf
https://www.youtube.com/watch?v=AKujV1nlASQ
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/workingwithincidentdata
https://drive.google.com/file/d/0B0bv14RMaOcfZ2ZMWklWbU1OUlk/view?usp=sharing
https://drive.google.com/file/d/0B0bv14RMaOcfZ2ZMWklWbU1OUlk/view?usp=sharing
https://www.youtube.com/watch?v=d9Gklj8KpUg
https://www.youtube.com/watch?v=xsfDG_GdK4k
http://desktop.arcgis.com/en/arcmap/latest/tools/conversion-toolbox/gpx-to-features.htm
http://desktop.arcgis.com/en/arcmap/latest/tools/conversion-toolbox/kml-to-layer.htm
http://desktop.arcgis.com/en/arcmap/10.5/map/working-with-layers/adding-x-y-coordinate-data-as-a-layer.htm
https://www.dnr.state.mn.us/mis/gis/DNRGPS/DNRGPS.html
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://youtu.be/6HBP3QqrbWA
https://drive.google.com/file/d/1QgDnNy1hvB0-WNLucPzeP9gw7PeImJeI/view
https://drive.google.com/file/d/1wSq-T6BbFgTj3GjHX96mBfqmvYKkB789/view
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://www.youtube.com/watch?time_continue=58&v=CmfKA-5_TCI
https://www.esri.com/arcgis-blog/products/arcgis-desktop/data-management/getting-the-most-out-of-editing-in-arcgis-10-tracing-features/
http://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-topology/aligning-an-edge-to-match-another-edge.htm
http://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-existing-features/replacing-the-geometry-of-an-existing-feature.htm
http://desktop.arcgis.com/en/arcmap/latest/manage-data/editing-attributes/editing-attributes-in-the-attributes-window.htm
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(d) When setting a Date/Time field use the Attribute Editor and the popup date picker to 
populate the attribute. After the date has been added the time can be added by 
entering the time in AM or PM. Example: 8/5/18 3:32 PM. 

(e) Make sure to populate the FeatureAccess, FeatureStatus and IsVisible fields if any 
Definition Queries (ArcMap or ArcGIS Pro) are used in maps. Utilizing the Event 
Attributes has information on using definition queries. 

(f) NOTE: To reduce the number of fields displayed in the Attributes window and make 
it easier to enter new attributes, turn off unnecessary fields in each layers’ properties 
(OBJECTID, SHAPE, SHAPE_Length, CreateName, CreateDate,EditName, 
DateCurrent, ContactEmail, ContactPhone, etc.). 

(3) Open the Attribute table and use the Calculate Geometry tool to populate the GISAcres 
field using the local projection for only polygons that were edited. (Watch AOI and only 
edit your incident) 

ii) Edit the EventLine Feature Class. (How To: Pro, ArcMap) 
NOTE: Line and Point edit order may be switched based on the most logical order for the 
incident. 

(1) Refer to Utilizing the Event Attributes How To or Video for attribute descriptions and 
how to use the Event GDB for various mapping scenarios. 

(2) Create or modify coincident EventLine features to match the fire polygon. 
(a) Use the appropriate feature template to trace the fire perimeter boundary to create the 

fire line features. 
(b) Alternately, copy the fire polygon and paste into the EventLine feature class to create 

new features. 
(c) Use the Split tool to divide the line based on the line type. Use Merge from the Editor 

toolbar to combine lines of the same type. 
(d) Modify any attributes using the Attribute Editor window. 

(3) Use the Create Features window to create any additional lines. 
(4) During or after creating all of the new line features, use the attribute editor window to 

bulk update the attributes for all of the fields possible. 
(5) Populate all Required Metadata fields listed in the Polygon editing section above. 
(6) When setting a Date/Time field use the Attribute Editor and the popup date picker to 

populate the attribute. After the date has been added the time can be added by entering 
the time in AM or PM. Example: 8/5/18 3:32 PM. 

(7) Make sure to populate the FeatureAccess, FeatureStatus and IsVisible fields 
appropriately if any Definition Queries (ArcMap or ArcGIS Pro) are used in maps. 
Utilizing the Event Attributes has information on using definition queries 

(8) From the feature class attribute table use the Calculate Geometry Tool to populate the 
LengthFeet field. Make sure to “Use coordinate system of the data frame” in your local 
projection (Figure One), in order to calculate length properly. (Watch AOI and only edit 
your incident). 
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http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/definition-query.htm
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
http://desktop.arcgis.com/en/arcmap/latest/manage-data/tables/calculating-area-length-and-other-geometric-properties.htm
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://youtu.be/se6dYbs805w
https://drive.google.com/file/d/1QgDnNy1hvB0-WNLucPzeP9gw7PeImJeI/view
https://drive.google.com/file/d/1wSq-T6BbFgTj3GjHX96mBfqmvYKkB789/view
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://www.youtube.com/watch?time_continue=58&v=CmfKA-5_TCI
https://www.esri.com/arcgis-blog/products/arcgis-desktop/data-management/getting-the-most-out-of-editing-in-arcgis-10-tracing-features/
http://desktop.arcgis.com/en/arcmap/latest/manage-data/editing-existing-features/splitting-lines-manually.htm
http://desktop.arcgis.com/en/arcmap/10.5/manage-data/creating-new-features/merging-features-in-the-same-layer.htm
http://desktop.arcgis.com/en/arcmap/10.5/manage-data/editing-attributes/editing-attributes-in-the-attributes-window.htm
http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/definition-query.htm
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
http://desktop.arcgis.com/en/arcmap/latest/manage-data/tables/calculating-area-length-and-other-geometric-properties.htm
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
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Property: I Length 

Coordinate System 

0 Use coordinate system of the data source: 
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PCS: NAD 1983 California Teale Albers 
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About calculabnq geometry 

X 

..__o_K _ _.! I Cancel 

Figure One: Calculate geometry for Polygons and Lines 

iii) Edit the EventPoint Feature Class. (How To: Pro, ArcMap) 
(1) Refer to Utilizing the Event Attributes How To or Video for attribute descriptions and 

how to use the Event GDB for various mapping scenarios. 
(2) Use the Create Features tool to digitize division and branch breaks at the locations 

provided by SITL and/or Operations. Divisions are usually arranged in alphabetical, 
clockwise order around the fire perimeter starting at the fire origin. Video: Branches and 
Divisions Part 1 and Part 2. 
(a) In the Label field, enter the name of the division that is clockwise from the division 

break; enter the text as it should appear on the map (ex. Div A). Examples of drop 
point, helispot and date attributes: DP-1, H-1, Aug 5 1643 hrs. 

(b) Both divisions and branches on each side of the break should be identified in the 
Comments attributes (Branch I-II, Div D-E). 

(c) If no branches currently exist on the incident, only the divisions on each side of the 
break will be identified in the Comments attribute (Div A-B or A-B). 

(d) Rotate the breaks so they are perpendicular to the fire perimeter. The break symbol 
can be rotated using the Rotate tool on the editor toolbar or by entering the rotation in 
degrees into the Angle field in the Attribute Editor. The Angle field stores the rotation 
for all symbols. 

(3) Create any new point features. 
(a) To create features using coordinates, select the appropriate feature type from the 

feature template, move the cursor over the map, right mouse click and select Absolute 
X,Y. Choose the appropriate coordinate format using the menu arrow on the right 
side of the “X” entry box, and then enter the coordinates. Press Enter. 

(4) During or after creating all of the new point features, use the attribute editor window to 
bulk update the attributes for all of the fields possible. 

(5) Populate all Required Metadata fields listed in the Polygon editing section above. 
(6) When setting a Date/Time field use the Attribute Editor and the popup date picker to 

populate the attribute. After the date has been added the time can be added by entering 
the time in AM or PM. Example: 8/5/18 3:32 PM. 

(7) Make sure to populate the FeatureStatus and IsVisible fields appropriately if any 
Definition Queries (ArcMap or ArcGIS Pro) are used in maps. Utilizing the Event 
Attributes has information on using definition queries 

(8) Enter the appropriate label for each feature in the Label attribute. 
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https://youtu.be/vJTfUwsDzbY
https://drive.google.com/file/d/1QgDnNy1hvB0-WNLucPzeP9gw7PeImJeI/view
https://drive.google.com/file/d/1wSq-T6BbFgTj3GjHX96mBfqmvYKkB789/view
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://www.youtube.com/watch?time_continue=58&v=CmfKA-5_TCI
https://www.youtube.com/watch?v=4vHyoaa8RpI
https://www.youtube.com/watch?time_continue=1&v=u045NIHnzvo
http://desktop.arcgis.com/en/arcmap/10.5/manage-data/cad/georeferencingtoolbar-using-the-rotate-tool.htm
http://desktop.arcgis.com/en/arcmap/latest/manage-data/creating-new-features/creating-a-point-at-an-exact-x-y-location.htm
http://desktop.arcgis.com/en/arcmap/latest/manage-data/creating-new-features/creating-a-point-at-an-exact-x-y-location.htm
http://pro.arcgis.com/en/pro-app/help/mapping/layer-properties/definition-query.htm
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
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(9) From the feature class attribute table use the Calculate Geometry Tool to populate the 
Latitude and Longitude in degrees-decimal-minutes format. Make sure to “Use 
coordinate system of the data source” WGS84. (Watch AOI and only edit your incident) 

Figure Two: Calculate Geometry for Points 

d) Save Edits and save Edit Project. 

e) Export latest fire perimeter to progression GDB for use in the progression maps. 
i) Create a Progression GDB in the \incident_data\progression folder (name per GSTOP 

standards). 
ii) Export the current fire perimeter to a new “progression” feature class and name per GSTOP 

standards using the date and time the fire perimeter data was collected 
iii) Export each updated fire perimeter. 

f) Calculate containment for the fire. Determine the percentages of completed line and uncontrolled 
fire edge. 
i) Ensure that the LengthFeet field has be updated since any edits were made. If uncertain, it is 

always best to recalculate geometry. (Watch AOI and only edit your incident) 
ii) Run Summary Statistics on EventLine using LengthFeet as the statistics field and 

FeatureCategory as the case field. If not all completed line is coincident with the fire 
perimeter, a selection may be set prior to running the tool so that only lines coincident with 
the perimeter are summarized. 

iii) Divide the total length of completed line by the total length of uncontrolled fire edge to 
determine the containment percentage. 

GISS Workflow - Version 1.0 - February 1, 2019 10 

http://desktop.arcgis.com/en/arcmap/latest/manage-data/tables/calculating-area-length-and-other-geometric-properties.htm
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
https://youtu.be/PLAFR5oyVi4
https://drive.google.com/file/d/1W7HLx6xQv-SiqZhl-B8jGShrvbQkEFLY/view
http://desktop.arcgis.com/en/arcmap/10.3/tools/analysis-toolbox/summary-statistics.htm


 
   

 
​ ​   

​ ​  
​ ​  

​ ​  
​ ​  

 
​ ​  

​ ​  
​ ​  

 
​ ​  

 
​ ​  

 
 

​  
​ ​ ​ ​  

 
​ ​ ​  
​  

 
​ ​  

​ ​  
​ ​  

 
 

​ ​  
 

​ ​  
 

​ ​  
  

 
  

         

Backup and Update the Master Incident GDB - Done after every Edit Cycle 
6) Internet Access? 

a) YES - Sync and then backup the Local Copy. 
i) Determine the path and name of the Local Copy. 
ii) Synchronize Local Copy with the NIFS 
iii) Create a copy of the Local Copy, paste into the daily backup folder under 

incident_data\backups and rename following GSTOP. 

b) YES - Sync and then convert the Download Map. 
i) Synchronize the the Download Map with the NIFS. 
ii) Determine the path and name of the Download Map Runtime GDB. The standard location is 

the folder set in the project options as the “Home Folder.” 
iii) Copy the Runtime GDB and paste into the daily backup folder under incident_data\backups 

and rename following GSTOP. 
iv) Use the Copy Runtime GDB to File GDB conversion tool to create a File GDB and rename 

following GSTOP.. 

c) NO - Backup Edit Incident GDB 
i) Create a backup of the Edit Incident GDB in the \incident_data\backups folder and name it 

following GSTOP standards. 
ii) Upload a copy of the backup to Fire Enterprise Geospatial Portal (EGP) Incident Data Portal 

when internet becomes available. 

7) Replace the Master Incident GDB with the current backup. 
a) Make sure no GISS are connecting to the existing Master Incident GDB. If there are any 

connections then a lock file will be created in the Master Incident GDB and it can not be 
deleted. Have all GISS exit ArcMap or ArcGIS Pro. 

b) Delete the current Master Incident GDB. 

c) Copy and Paste the current backup into the \incident_data folder. 

d) Rename the GBD to the same name as the previous Master Incident GDB. If file names are not 
exactly the same the source paths in the ArcMap and ArcGIS Pro maps will not be correct. 

GISS Workflow - Version 1.0 - February 1, 2019 11 

http://desktop.arcgis.com/en/arcmap/10.3/tools/conversion-toolbox/copy-runtime-geodatabase-to-file-geodatabase.htm
https://egp.nwcg.gov/egp/default.aspx
https://egp.nwcg.gov/egp/ImportExport.aspx
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Map Cycle - Repeat As Necessary 
8) Create or Update Incident Maps 

a) Use existing master incident project or open a template and save as a master map document per 
GSTOP. 
i) Whenever possible use an existing project as a basis for the new project. Update yesterday's 

IAP to make today’s, change the page size on an IAP map and save as a Situation map or 
Briefing map. 

ii) Or use an Event Map Template to speed map production. 
(1) Resource: Unit 2G - Creating Map Layouts Using Templates 
(2) Video: Creating Map Layouts Using Templates 
(3) Video: Anatomy of An Event Map Template 
(4) Video: Using An Event Map Template 

iii) Save per GSTOP standards in the \projects folder. 

b) Set the data frame to a local projection. If the local projection is unknown, set the dataframe to 
UTM NAD83 and zone based on location. 

c) Add 2019_Event_Features_PointLabelsDefined.lyr (from /tools folder) template layer and repair 
path to point to the Master Incident GDB in the incident_data folder. 

d) Add base maps and ancillary datasets to map. Add the topo maps layer file created earlier. 

e) Create a layout for the desired map product or apply template to existing project. 
i) Incident Map Types: 

(1) Incident Action Plan 
(2) Multi-Page (Tiled) 
(3) Briefing (BAM) 
(4) Situation 
(5) Transportation 
(6) Progression 
(7) Air Operations 
(8) Operations 
(9) Other 

ii) In the Layout View, leave room (in Data Frame) in the direction the fire is burning, as the 
fire will grow, and reset the map scale to 1:24,000. 

iii) Appropriately size and position the map elements in the layout to not block any features. 

f) Use definition queries to display the Event features appropriately for the intended map audience. 
i) Refer to Utilizing the Event Attributes How To or Video for definition query examples using 

the Event GDB for various mapping scenarios. 

g) Create division and branch annotation. Resource: Unit 2F - Labeling and Annotation. 
i) Convert the labels to annotation (Resource: Unit 2F Convert Labels to Annotation using Pro 

or ArcMap) 
ii) If using the 2019_Event_Features_PointLabelsDefined.lyr the labels are already configured 

for an IAP Map. 
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https://drive.google.com/file/d/19KU4Errb6vzhjnsq6k18wqdeW65ibGdE/view?usp=sharing
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/layoutsandtemplates
https://www.youtube.com/watch?v=jVotOEUDHNo
https://www.youtube.com/watch?v=j7ELpyHXzrk
https://www.youtube.com/watch?time_continue=1&v=tNZjb3Dv3AU
https://en.wikipedia.org/wiki/Universal_Transverse_Mercator_coordinate_system
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/layoutsandtemplates
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/iap
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/multipage
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/briefing
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/situation
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/transportation
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/progression
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/air-operations
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/operations
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit3/other
https://drive.google.com/file/d/1x36ALjVBokx-XWkMMg9hMQNISR6PFvjQ/view
https://www.youtube.com/watch?time_continue=58&v=CmfKA-5_TCI
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/labelingannotation
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/labelingannotation
https://drive.google.com/file/d/13m8NtGrPb3qzYhfqlMFfGkQ_1miZiMgy/view?usp=sharing
https://drive.google.com/file/d/13m8NtGrPb3qzYhfqlMFfGkQ_1miZiMgy/view?usp=sharing


 
​ ​  

​ ​  
​ ​  

 
 

 
  

 
​ ​  

 
 

​ ​ ​  
​  

​  
​  

 
​ ​  

​  
​ ​  

​  
​  
​  
​  

 
​  

​  
​  

​   
​ ​  

 
​  

  
  

   

    

        
      
     

   

       

 
​  

  
​ ​  

         

iii) Set the appropriate map scale and Convert Labels to Annotation for the EventPoint feature 
class in other_incident_data.gdb per GSTOP. 

iv) Note: Do not create Feature Linked annotation. GISS with ArcGIS Basic licenses are not 
able to edit the EventPoint feature class and annotation layers if this is done. 

v) Move annotation features to optimize readability. This can either be done in the map view or 
by focusing the data frame in the layout view for ArcMap. ArcGIS Pro annotation editing is 
done within the Map view. 

h) Use dynamic labeling or create annotation in separate GDB (in Other_Incident_Data.gdb) for 
any other features. 

i) Ensure that all standard map elements are present and correct (STANDL SGD). Video: Map 
Symbology and Standard Map Elements. GSTOP page 56. 
i) Scale 
ii) Title 

(1) Use Dynamic Text based on the map Document Properties to update layout elements. 
Resource: Unit 2H - Dynamic Text. 

(2) Use an Event Map Template which includes dynamic text. Video: Anatomy of An Event 
Map Template Video: Using An Event Map Template 

iii) Author 
iv) North Arrow 
v) Date 
vi) Legend 

(1) When using a dynamic legend activate the “only show classes that are visible in the 
current map extent”. 

vii)  Source Statement 
viii) Graticule/Grid 
ix) Datum 
x) Add logos, QR codes, and other map elements. 

j) Export map to PDF and name and store appropriately per GSTOP standards. Resource: Unit 4D -
Geospatial PDF 
i) Use the following export settings to create a good quality PDF: 

Resolution 300 dpi 

Output Image Quality Best 

Boxes checked (selected) for: ☑ Compress Vector Graphics 
☑ Convert Marker Symbols to Polygons 
☑ Embed All Document Fonts 

Image Conversion Adaptive 

Picture Symbol Vectorize layers with bitmap markers/fills 

ii) Use the following information in the file name: {mapname}_{pagesize}_{orientation} 
_{date}_{time}_{incident name}_{ Unit + Local Incident ID}_ {operational period}.pdf 

iii) For S-341 add _ {your_name} to the end of the file name. 
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http://desktop.arcgis.com/en/arcmap/latest/map/working-with-text/converting-labels-to-annotation.htm
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit1/mapsymbologyelements
https://www.youtube.com/watch?time_continue=1&v=_utf0iAvtYg
https://www.youtube.com/watch?time_continue=1&v=_utf0iAvtYg
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/Unit2/dynamictext
https://www.youtube.com/watch?v=j7ELpyHXzrk
https://www.youtube.com/watch?v=j7ELpyHXzrk
https://www.youtube.com/watch?time_continue=1&v=tNZjb3Dv3AU
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/qrcodes
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/geospatialpdf
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/geospatialpdf
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k) Backup projects in the projects\backups folder per GSTOP. Use the File > Save A Copy tool to 
backup master MXD or APRX in the appropriate folder. 

Backup and Post - Repeat as Necessary 
9) Post map products to NIFC FTP site nightly in appropriate date subfolders. Use QR codes to 

reference folders. Resource: Unit 4B - FTP.NIFC.GOV. 

10) Backup the entire incident directory structure to an external device. Resource: Unit 4C - Backup, 
Share and Archive Incident Data. 
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https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/ftp
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/backuprecovery
https://sites.google.com/a/firenet.gov/gisstraining/home/gissintroductoryclass/unit4/backuprecovery



